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This readme contains information for both iDRAC7 and LC2-RS. 
 
iDRAC7 is a systems management hardware and software solution that provides remote management capabilities, crashed 
system recovery, and power control functions for Dell PowerEdge systems. 
 
LC2-RS provides advanced embedded systems management and is delivered as part of iDRAC7. LC2-RS enables remote 
systems management in a one-to-many method.  Remote Services uses WS-Management (WS-MAN) protocol based Web 
services interface to remotely provision and manage the servers. 

 

What’s New  
None 
 

Hardware and Software Requirements 

License Requirements 
 Software licensing has replaced hardware licensing. For more information, see, the Dell License Manager User's 

Guide.  

 Lifecycle Controller features such as Auto Discovery and vFlash are now licensed. You must install the correct 

licenses for Lifecycle Controller Remote Services to work properly. 

Supported Systems 
iDRAC7 and LC2-RS is supported on the following Dell PowerEdge systems: 

 Dell PowerEdge M620 

 Dell PowerEdge R620  

 Dell PowerEdge R720  

 Dell PowerEdge R720xd  

 Dell PowerEdge T620 

Supported Managed Server Operating Systems for iDRAC7 
The following operating systems support iDRAC7: 

 Microsoft Windows Server 2008 SP2 (Standard, Enterprise, and DataCenter Editions) (x86, x86_64) 

 Microsoft Windows Server 2008 R2 SP1 (Standard, Enterprise, and DataCenter Editions) (x86_64) 

 Microsoft Windows Small Business Server 2011 (x86_64) 

 SUSE Linux Enterprise Server (SLES) 10 SP4 (x86_64) 

 SUSE Linux Enterprise Server (SLES) 11 SP2 (x86_64) 

 Red Hat Enterprise Linux (RHEL) 5.7 (x86_32, x86_64) 

 Red Hat Enterprise Linux (RHEL) 6.1 (x86_64) 

 Hyper-V and Hyper-V R2 

 ESX/ESXi 4.1 Update 2 Flash, Classic, and HDD 

 ESXi 5.0 Patch 01 Flash 

 XenServer 6.0 

  



Supported Web Browsers for iDRAC7 
 Microsoft Internet Explorer 7.0 for Windows Server 2003 SP2, Windows Server 2008 SP2, Windows XP 32-bit 

SP3, and Windows Vista(R) SP2 

 Microsoft Internet Explorer 8.0 for Windows Server 2003 SP2, Windows Server 2008 SP2, Windows Server 

2008 R2 x64, Windows XP 32-bit SP3, Windows 7, and Windows Vista SP2. Internet Explorer 8 requires Java 

Runtime Environment (JRE) version 1.6.14 or later 

 Microsoft Internet Explorer 8.0 (64-bit) for Windows 7 (x86_64), Windows Vista (x86_64) and Windows Server 

2008 R2 (x86_64), Windows Server 2008 SP2 (x86_64), Windows Server 2003 SP2 (x86_64) 

 Microsoft Internet Explorer 9.0 for Windows Server 2008 R2 x64, Windows 7, and Windows Vista(R) SP2 

 Microsoft Internet Explorer 9.0 (64-bit) for Windows 7 (x86_64), Windows Vista (x86_64), and Windows 

Server 2008 R2 (x86_64) 

 Mozilla Firefox 6.0 and 7.0 on Windows XP 32-bit SP3, Windows Server 2003 SP2, Windows Server 2008 SP2, 

Windows Server 2008 x64 R2, Windows Vista SP2, Windows 7 

 Mozilla Firefox on SLES 10 x64 SP3, SLES 11 x64 SP1, RHEL 5.5, and RHEL 6.0 x64 Native version 

Installation 
iDRAC7 - Installation 

Prerequisites 
Before you update iDRAC7 firmware using local RACADM or the Dell Update Package, perform the following procedures. 

Otherwise, the firmware update operation may fail. 

1. Install and enable the appropriate IPMI and managed node drivers.  

2. If your system is running a Windows operating system, enable and start the Windows Management Instrumentation 

(WMI) service. 

3. If you are using iDRAC7 Enterprise and your system is running SUSE Linux Enterprise Server (version 10) for Intel 

EM64T, start the Raw service. 

4. Disconnect and unmount Virtual Media. 

5. If iDRAC7 firmware update is interrupted for any reason, you must wait for at least 30 minutes before you start the 

firmware update again. 

Installation and Configuration Notes 
 From the Windows host operating system (managed node), run the Dell Update Package for Windows and follow 

the instructions on the update wizard. 

 From the Linux host operating system (managed node), run the Dell Update Package for Linux from the shell 

prompt. Follow the instructions displayed on the console. 

 From the management station, remotely update the firmware using the iDRAC7 Web interface: 

1. Extract the firmware image self-extracting file to the management station. 

2. Open the iDRAC7 Web interface using a supported Web browser. 

3. Log in as administrator. 

4. Go to Overview > iDRAC Settings > iDRAC Firmware Update. The Firmware - Upload / Rollback (Step 1 of 3) 

page is displayed. 

5. Click Browse, select the d7 firmware image file that you extracted (step 1), and click Upload. 

6. Wait for the upload to complete. After the upload is completed, the existing and the new firmware 

version numbers are displayed.  

7. Click Update. After the update is completed, iDRAC7 restarts automatically. 



 

Upgrade 
iDRAC7 firmware cannot be installed on platforms that support iDRAC6 and cannot be used to upgrade iDRAC6 firmware to 

iDRAC7. 

Uninstallation 
Use the rollback feature to return to the previous installed version of iDRAC7 firmware. 

Lifecycle Controller 2 Remote Services - Client Tools 

Use the WinRM and OpenWSMAN CLI client tools to send WS-MAN commands to Lifecycle Controller. 

WinRM 

WinRM is a Windows native WS-MAN client. 

It is recommended to use WinRM 2.0 on Windows Management Stations. WinRM 2.0 is installed by default as a part of 
Windows 7 and Windows Server 2008 R2. It can also be installed as a part of the Windows Management Framework Core 
package on the following systems: 

 Windows Server 2008 SP1 

 Windows Server 2008 SP2 

 Windows Server 2003 SP2 

 Windows Vista SP1 

 Windows Vista SP2 

 Windows XP SP3 

For more information on how to install WinRM 2.0 as a part of the Windows Management Framework Core package, see 
article 968929 in the Microsoft Knowledge Base at: 

http://go.microsoft.com/fwlink/?LinkId=186253 

Recommended WinRM Client Configuration 

 MaxBatchItems = 50 

 MaxTimeoutms = 60000 

 MaxEnvelopeSizekb = 150 

 NetworkDelayms = 60000 

  

http://go.microsoft.com/fwlink/?LinkId=186253


Sample WinRM Command (Enumeration Operation): 

winrm e cimv2/DCIM_SystemView?__cimnamespace=root/dcim -u:[idrac user]  

-p:[idrac password] -r:https://[idrac ip adddress]/wsman -encoding:utf-8  

-a:basic -SkipCNcheck -SkipCAcheck -format:Pretty 

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed certificates are not 
accepted by the WinRM client and WinRM commands do not work without these options:  

-SkipCNcheck and –SkipCAcheck 

OpenWSMAN CLI 

OpenWSMAN CLI is an open source Linux WS-MAN client. OpenWSMAN CLI source code and installation details are available 

at: 

http://sourceforge.net/projects/openwsman/files/wsmancli 

Sample OpenWSMAN CLI Command (Enumeration Operation): 

wsman enumerate http://schemas.dmtf.org/wbem/wscim/1/cim-schema/2/DCIM_SystemView  

-h (idrac ip adddress) -P 443 -u (idrac user) -p (idrac password) -v -j utf-8  

-y basic -R -o -m 256 -N root/dcim -c cert_name.cer –V 

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed certificates are not 

accepted by the OpenWSMAN CLI client and WS-MAN commands do not work without these options: -c, -v, and –V  

See the OpenWSMAN CLI Readme for details on these options. 

iDRAC - Notes 
 Only if there are one or more network interface cards (NDC or LOM) present on the managed system, Network 

Devices appears under Overview > Hardware in the iDRAC7 Web interface. 

 When using iDRAC7 Web interface in Firefox 3.6 if the SD card is removed while partition creation is in-progress, 

the operation has been completed successfully message is displayed. 

 If Virtual Console and Virtual Media are configured to use Java plug-in, then you must disable Enhanced 

Security Mode in Internet Explorer. If this is not possible, then in iDRAC7, configure Virtual Console to use 
ActiveX plug-in.  You must enable ActiveX control in IE, add the iDRAC7 Web URL to the Intranet security zone, 
and set the security level for this zone as Medium-Low for Virtual Console and Virtual Media to function properly. 

 If the instant messenger is launched in the Virtual Console viewer with ActiveX native plug-in and another 
application is started (example Notepad, WordPad, and so on) without minimizing the Virtual Console, the instant 
messenger box also pops-up on other applications. This does not happen with Java plug-in. 

 When a system is in POST, it is not possible to attach a vFlash partition as the First Boot Device. 

 Virtual Console Viewer from iDRAC7 Web interface terminates when the managed system is restarted. 

 If common logging is enabled in iDRAC7, CEM storage inventory takes more than 40 minutes. If common logging is 
disabled (default setting), CEM storage inventory takes up to four minutes for the maximum configuration. 

 A pop-up message is not displayed to confirm if test emails are successfully sent or not. 

http://sourceforge.net/projects/openwsman/files/wsmancli


 

 For iDRAC7 Enterprise, when the Virtual Console is disabled and Virtual Media is disabled and/or detached, the 
console port (default: 5900) remains open.  For iDRAC7 Express (no Virtual Console or Virtual Media) the console 
port is open. 

 If auto-negotiation is enabled while setting iDRAC7 network, 1 Gbps is not supported and you cannot manually 
select it. 

 A USB device mounted through Virtual Media in floppy emulation mode for a Linux operating system shows as a 
removable volume. 

 During system power operations, if the video mode changes, the message Out of range may appear for a short 
while on the Virtual Console. 

 When using the Virtual Console in native console mode with Pass all keystrokes to server disabled in 
Internet Explorer versions 8 and 9, if an F1/F2 prompt is encountered, pressing F1 displays the Virtual Console 
online help pop-up in addition to continuing with the system boot. 

 When any of the storage enclosure components are removed, the corresponding details are not displayed. Only the 
name and status attributes are displayed. 

 When certain RAID operations are requested using WS-MAN on non-RAID cards such as, the Dell SAS 6Gbs HBA or 

the Internal Tape Adapter, the operation succeeds, however the job fails with the error message Unable to 

locate device in current configuration. 

 If the iDRAC7 network is configured to use a shared LOM and the spanning tree is enabled on the LOM port, WS-
MAN and remote service commands may time-out in the following scenarios: 

o At system reboot 

o When CSIOR is running 

o While entering SSM 

The connectivity lost is variable. In typical cases, it is approximately: 

o 40 seconds at system reboot and varies per NIC or link speed 

o 20 seconds when CSIOR is running 

o 40-60 seconds while entering SSM 

The reason is that when spanning tree is enabled, the switch does not allow the link to re-establish the connection after a 
reset until it completes checking for network loops. Server reboots reset the NIC and disconnects the link. 

Note: This does not occur while using dedicated NIC because server reboots do not affect the dedicated NIC. 

 When logging in to iDRAC7 Web Interface using Internet Explorer 9 and IPV6 address, the connection may not 
succeed. To resolve this, make sure that in Internet Explorer > Tools > Internet Options > Connections > LAN 
Settings, the Use automatic configuration script option is cleared. 

iDRAC7 - Limitations 
 If floppy emulation is enabled when a bootable USB key is mounted as a Virtual Media from the Virtual Console and 

if you try to delete any file from the mounted USB key (floppy), the blue screen appears immediately. 

 Web server session time-out is not exact. It is either 10% more or 15 seconds more, whichever is greater. 

 WinRM and RACADM commands may become unresponsive during BIOS update or when setting BIOS, NIC, or RAID 
attributes through Lifecycle Controller. 

 Using WS-MAN and running up to 256 jobs through the job scheduler may lead to reduced iDRAC7 performance. 



 If invalid credentials are used for the maximum login attempts, the IP is blocked for the duration of the IP Blocking 
Penalty Time and a message is not displayed. 

 If Internet Explorer (IE) 64-bit browser is used to log in to iDRAC7 Web interface and when viewing the power 
usage graph, the X and Y axis labels appear too small to read. This is a known limitation for IE 64-bit only. The 
labels appear correctly in IE 32-bit browser. 

 On Linux management stations, if Firefox is launched from the root user, a USB key is mapped in Virtual Media 
successfully. If Firefox is launched from any user other than the root user, a USB key is not shown for mapping 
because the user must have root privileges to access all the low-level drives. 

 Alert notification for battery events does not work. 

 Operating system information on the System Summary page does not display after rebooting iDRAC7 until the 
operating system is rebooted. 

 iDRAC7 users with user names containing a semi-colon (;) cannot log in to iDRAC7 through SSH. 

 In the iDRAC7 Web interface, the power consumption sensor reading may have a rounding error of up to 13 Watts 
depending on the actual power reading. This is an IPMI limitation. The power cap, power graphs, cumulative 
power, and peak power are not affected by this inaccuracy. However, the power values shown in the power graphs 
are average values over a period of time and should not be used to calculate instantaneous power. 

 In the iDRAC7 Web interface, the power consumption sensor reading may have a rounding error of up to 13 Watts 
depending on the actual power reading. This is an IPMI limitation. The power cap, power graphs, cumulative 
power, and peak power are not affected by this inaccuracy. However, the power values shown in the power graphs 
are average values over a period of time and should not be used to calculate instantaneous power. 

 In the iDRAC7 Web interface, while viewing the CPU details under Overview > Hardware, the CPU status is 
displayed with a warning icon for a CPU that is absent and the status is blank. 

 
iDRAC7 - Open Issues and Resolutions 
Fixed Issues/def 

Issue 1 

Description 

In Chinese locale on Windows operating system, while launching the Virtual Console using Java plug-in, occasionally you may 
see a Java compilation error.  

Resolution 

1. Open the Java control panel. 

2. Go to General > Network Settings. 

3. Select Direct Connection and click OK. 

Versions Affected 

All iDRAC7 supported Dell PowerEdge systems.  

Issue 2 

Description 

Known iDRAC7 IPv6 limitations: 

 Email alerts are not sent if the iDRAC7 DNS Domain Name is not specified when using IPv6. 

 Network File Share (NFS) mounting does not work with IPv6. This applies to features such as connecting a remote 
file share or exporting the Lifecycle Controller log to a network shared location. 



 

 Firefox versions 4.x, 6.x, and 7.x may prevent the iDRAC7 Web interface from opening when using IPv6. For more 
information see:  

https://bugzilla.mozilla.org/show_bug.cgi?id=633001 

 On Microsoft Windows Operating Systems, when launching Virtual Console using Java plug-in or when launching 
Video Capture plugin, empty warning dialogs may appear. Continue to click OK to launch plugin. This is a known 
limitation in Java Web Start if its Network Settings is set to use browser settings. To resolve this, set the Java's 
Network Settings to Direct Connection. 

Resolution (only for logging in to iDRAC7 Web interface): 

1. Register iDRAC7 to DNS. 

2. Make sure the client system also has this DNS in its DNS list. 

3. Enable IPv6 and disable IPv4. 

4. Log in to iDRAC7 using the Fully Qualified Domain Name (FQDN). 

For launching Virtual Console with IPv6 in Firefox 4.0 or later versions, from Windows management system, run ipconfig 

/flushdns in the command prompt.Versions Affected 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

Issue 3 

Description 

The Learn More pop-up on the License page does not appear using IE. 

Resolution 

Add *.dell.com to the trusted sites in the Security settings. See the Internet Explorer help documentation for more 
information. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

Issue 4 

Description 

On Windows operating system, to add a folder as an image using the Virtual Media, the Desktop directory must be in the 
HOMEPATH directory. The HOMEPATH directory may vary depending on the Windows installation, but the images created 
from the Add Folder as Image operation always reside in the %HOMEDRIVE%\%HOMEPATH%\Desktop directory. The   
HOMEDRIVE must be set to C drive. Otherwise, the operation fails. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

  

https://bugzilla.mozilla.org/show_bug.cgi?id=633001


Issue 5 

Description 

If you are using Linux management station, you may have problems moving or resizing the Virtual Console when Pass all 
keystrokes to server is enabled. This is a limitation of X-Windows. 

Resolution 

Either disable Pass all keystrokes to server if the problem occurs or click in the workspace outside the Virtual Console 
window so that the console loses focus. Now, reposition and resize the Virtual Console. The keystroke option is restored if it 
was in use and temporarily disabled. 

Versions/Systems Affected 

All iDRAC7 supported Dell PowerEdge systems. 

Issue 6 

Description 

vFlash functionality remains enabled after unpreserved firmware update.  

If vFlash functionality is enabled and a firmware update is performed without preserving the configuration (preserve 
configuration unchecked), the vFlash enabled option remains selected. This is a known behavior. 

Resolution 

You must manually enable or disable the vFlash functionality after the firmware update as required. To do this, select or 
clear the vFlash Enabled option in the iDRAC7 Web interface, or use RACADM or WinRM remote service commands. 

Versions/Systems Affected  

All iDRAC7 supported Dell PowerEdge(TM) systems. 

Issue 7 

Description 

In some scenarios, typically for state change events occurring within a span of few seconds, the sequence of events 
reported in the Lifecycle Log (or corresponding SNMP traps) for storage devices may not exactly match the sequence in 
which they occurred. 

Resolution 

The current state or attribute of the storage device can be checked in any of the iDRAC7 interfaces (example, iDRAC7 Web 
interface, RACADM and so on). 

Versions/Systems Affected  

All Dell PowerEdge(TM) systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

  



 

Issue 8 

Description 

When enclosures connected in the redundant path are re-wired (connections are switched) to result in a non-redundant 
path, the reported connected port value of the enclosures may not be accurate. 

Resolution 

Power cycle the server. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 9 

Description 

When a storage enclosure is disconnected or accidentally removed, the corresponding status of its components (that is, EMM, 
PSU, fan, and temperature sensors) are reported as critical. 

Resolution 

If the storage enclosure is disconnected accidentally, reconnect it to get back to normal state. If it is intentional, perform 
DRAC7 reboot or server power cycle to remove the enclosure entries from the consoles. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 10 

Description 

Logging in to iDRAC7 Web interface fails with the error message 'RAC0218: The maximum number of user sessions is reached'. 
When the temporary folder used by iDRAC7 components is full, it is possible that authentication fails and this error is 
displayed. 

Resolution 

Power cycle iDRAC7 to clear the temporary space. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

  



Issue 11 

Description 

On Microsoft Windows7 operating system, while launching Virtual Console in native mode using Internet Explorer, the 
iDRAC7 Login page is displayed. 

Virtual Console uses plug-ins and due to insufficient privileges plug-in does not load and iDRAC7 Login page is displayed. 

Resolution 

Reboot operating system and log in to iDRAC7 Web interface. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 12 

Description 

When selecting browser buttons (forward or back), the GUI pages are not displayed correctly and sometimes the same page 
re-appears.  

iDRAC7 Web interface is a platform management application and all the necessary controls are provided within the 
application. The Web browser buttons are outside of this application and may not function properly. 

Resolution 

Use the navigation options within the iDRAC7 Web interface. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 13 

Description 

When you log in to iDRAC7 Web interface using Internet Explorer 9.x, few pages are not shown properly. 

This is a known issue with Internet Explorer. 

Resolution 

1. Press F12. The Internet Explorer 9 Debug window is displayed. 

2. Select Document Mode > Internet Explorer 7. The browser refreshes and the iDRAC7 Login page is displayed. 

3. Close the Internet Explorer 9 debug window. 

4. Close all open Internet Explorer windows. 

5. Open Internet Explorer and log in to iDRAC7. 

For more information, see Internet Explorer documentation. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 



 

Issue 14 

Description 

When Enterprise or Enterprise Evaluation license expires, Active Directory is disabled automatically. 

Resolution 

After re-installing the Enterprise or Enterprise Evaluation license, administrative user can log in as an existing local iDRAC7 
user to re-enable Active Directory authentication, through available interfaces such as RACADM or iDRAC7 Web interface. 
Remote RACADM can be used in script to batch-enable Active Directory. If a local iDRAC7 user is not enabled or not 
configured for direct remote access, the administrative user must use local RACADM or OpenManage Server Administrator to 
configure a local user. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 15 

Description 

When a power reset is performed, the Virtual Console Viewer menu options (except File > Exit and Help options) are 
grayed-out or inaccessible. The 'Link interrupted' message appears at the bottom of Virtual Console Viewer. 

Resolution 

Due to a temporary network outage, the Virtual Console Viewer menu options are not accessible. The ‘Link interrupted’ 
message is displayed to indicate that an outage has occurred. This is a temporary problem and the menu options are 
available when the network is restored. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 16 

Description 

The Front Panel page in the iDRAC7 Web interface and the physical LCD on the server front panel may display IPv6 address 
as undefined even if IPv6 was enabled. 

Resolution 

Perform one of the following to view the IPv6 address: 

 Wait for the IPV6 DHCP6 server to respond and display the IPv6 address. 
or 

 In the iDRAC7 Web interface, go to Overview > iDRAC Settings > Properties. Under the Current IPv6 Settings 
section, see Link Local Address, which is the IPv6 address. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

  



Issue 17 

Description 

When a driver pack DUP update is performed, the following message is recorded in the Lifecycle log after the driver pack 
update entry. 
    RAC0400: iDRAC memory low   
    iDRAC is running low on memory. System performance may be degraded. 
Recommended Action: No response action is required. 

Resolution 

No workaround is required. This is a normal condition when the memory is lower than the threshold for around 30 seconds 
and returns to normal after the drive pack update. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 18 

Description 

Resetting iDRAC7 to default values action may take between four to six minutes to complete. 

Resolution 

Wait for iDRAC7 to reboot before performing any other action. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 19 

Description 

While deploying Windows 2008 R2 SP1 from Lifecycle Controller GUI > OS Deployment, installation terminates with the 
following error: 
    There is no disk in the drive. Please insert a disk into drive \Device\Harddisk0\DR0. 
  This issue may occur due to any of the following reasons 

 Virtual Media is in the attached state with no media mapped. 

 Virtual Media is in the auto attached state with media mapped.   

 Virtual Media being presented by the AVCT SIP and Virtual Media from iDRAC7 in the detached state.   

 The underlying cause may be due to failure to load drivers for RAID controllers on the system. 
 
  NOTE: It does not happen with Virtual Media in the detached state. It also does not happen without the SIP and with 
Virtual Media in the detached state from iDRAC7. 

Resolution 

Retry the operation. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

  



 

Issue 20 

Description 

In the iDRAC7 Web interface > Overview > Server > Power/Thermal > Power Monitoring tab > Power section, the Power 
Unit selector only changes the unit of measure. Due to the oscillating nature of power, the present reading cannot be 
displayed as units for Current (Amps). 

Resolution 

None. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 21 

Description 

On all Intel NICs, each port cannot be assigned different iSCSI initiator name (by assigning the value for IscsiInitiatorName). 
If the name is changed for one port, the same change is applied to all ports. 

Resolution 

None. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 22 

Description 

When virtual world wide name and virtual world wide port name attributes on a NIC partition are set using the WS-MAN 
interface, the new values are not updated in the iDRAC7 Web interface or when racadm getsysinfo is run. 

Resolution 

Use WS-MAN interface to obtain the updated values for those attributes. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7. 

Issue 23 

Description 

After a virtual disk is renamed using OpenManage Server Administrator or other applications, the new name is not displayed 
in the iDRAC7 Web interface or RACADM. 

Resolution 

For the specific virtual disk, change other attributes such as read policy, write policy and the modified name of the virtual 
disk is displayed. 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 



Issue 24 

Description 

After performing storage operations on PERC through Option-ROM (CTRL-R) or before a system reset (warm boot), the 
corresponding events are not recorded in Lifecycle log. SNMP traps are generated and the corresponding inventory changes 
are not reflected in the iDRAC7 Web interface or RACADM. 

Resolution 

To update the storage inventory, perform a server power cycle (cold boot). 

Versions/Systems Affected  

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers. 

Issue 25 

Description 

If a NIC card, with partitioning enabled, is replaced with a similar type of card, without partitioning enabled, the 
configurations from the previous card are not applied to the new card. 

Resolution 

After the previous card is replaced with a new card and the system is powered on, go to Option ROM (CTRL-R) and enable 
partitioning. Save, exit, and reboot the system. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

Issue 26 

Description 

When using DownloadServerPublicKey or DownloadClientCerts commands in WSMAN, the invocation may fail when the 
iDRAC7 system is not ready to service these operations. 
This might happen when host system is in a POST stage. 

Resolution 

Retry the command later or wait until host system past POST stage and retry the same command again. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

  



 

Issue 27 

Description 

When launching Virtual Console viewer using ActiveX plugin, sometimes a blank window appears and Virtual Console viewer 
may not launch. 

Resolution 

This may be due to incompatible binaries from previous version. Remove temporary files from download location on your 
system and retry.  
For example, C:\windows\Downloaded Program Files. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

Issue 28 

Description 

When video player is launched it launches both playback control window and playback window.  On Linux RHEL6.0 work 
station, if playback window lost focus then user cannot switch back by using mouse. It is not an issue on Microsoft Windows 
workstations. 

Resolution 

This is an issue with the RHEL 6.0 version of Linux.  Close the playback control window by selecting 'x' and select playback 
program on task bar using mouse to bring up playback window.  If you need to bring up playback controls again then select 
menu item from playback window. 

Versions/Systems Affected 

All Dell PowerEdge systems with iDRAC7. 

LC2-RS – Notes 

 Auto Discovery messages are now recorded in the Lifecycle Log. 

 Driver Pack updates no longer require a reboot. 

 The ‘Automated Task Engine’ screen now displays scheduled jobs with a ‘Running’ status unlike previous versions. 

 Empty partitions are created quickly when other partitions are not in use. If other partitions are in use, then 
creating an empty partition takes longer. For example, attach partition, format partition, and so on. 

 Lifecycle Controller job scheduling is enhanced. Jobs scheduled in the same group are executed in a sequence. 
Jobs that are not in the same group and scheduled at the same time execute at the scheduled time in parallel. 

 Passwords included in URI strings must use the correct percent-encoding format. 

 The string value for Challenge-Handshake Authentication Protocol (CHAP) passwords must have either zero or 
between 12 to 16 characters. 

 Changing the system password and locking the password cannot be done in a single Lifecycle Controller job. Run a 
job to change the password, reboot the host, and then run another job to lock the password. 



 System Characterization must be enabled to correctly run the firmware update during system power on after a 
Power Supply Unit (PSU) replacement. If System Characterization is not enabled, the firmware update runs after 
the next host reboot. 

 If the system is shut down or left in the shutdown state while a job is in progress, the job cannot progress further. 
Delete the job and run it again. 

 
LC2-RS - Open Issues and Resolutions 

Issue 1 

Description 

When the status of the DUP update is checked using the WS-MAN query for the job InstanceID of the DCIM_LifecycleJob, the 
'Percentage Complete' parameter value displays 'NA' even though the job is in-progress or complete. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

Issue 2 

Description 

After running a BIOS or NIC job, if you pause (by pressing Pause key on keyboard) during POST and run another BIOS or NIC 
job, it fails. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

Issue 3 

Description 

While performing platform update using the NFS share option, if the NFS service is stopped or network connection to the 
NFS share is lost while the job is in a downloading state, the job does not fail and continues to stay in a downloading state. 

Resolution 

To change the job status to: 

 Downloaded successfully - Restart the NFS service or re-establish the network connection. 

 Failed - Reset iDRAC7. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

  



 

Issue 4 

Description 

When two PSUs of same wattage and make are replaced and Part Replacement (Allow Version Upgrade only or Match 
firmware of replacement part option) feature is enabled, during platform update, the following behavior is observed: 

After the first PSU firmware update is complete, the Lifecycle log shows that both the PSUs are updated even though the 
firmware update for the second PSU is in progress. After the second PSU firmware update is complete, the Lifecycle log is 
not updated again. 

Resolution 

Query the job status using the job ID for the second PSU to get the correct status. 

Versions/Systems Affected  

All LC2-RS supported Dell PowerEdge systems. 

Issue 5 

Description 

LC-Remote Services jobs may fail occasionally to perform the required operations (either due to manual intervention or 
system failure) and the user cannot create a new job on the same component. 

Resolution 

Delete all the jobs. 

Versions/Systems Affected 

All LC2-RS supported Dell PowerEdge systems. 

Issue 6 

Description 

During POST, the message ‘Lifecycle Controller update required’ appears at the top right of the screen. This indicates 
that Lifecycle Controller is in recovery mode. This issue may occur due to Lifecycle Controller corruption or if an earlier 
model of Avocent SIP is used. 

Resolution 

To bring Lifecycle Controller out of recovery mode: 

1. During POST, press F2 go to System Setup > iDRAC Settings. 

2. Under iDRAC settings, go to Lifecycle Controller and set Lifecycle Controller to Enabled. 

3. Click Back, click Finish, and then click Yes. 

If Lifecycle Controller continues to be in recovery mode, perform a remote Lifecycle Controller update using WSMAN. 

  



 
Global Support 
 
For information on technical support, visit www.dell.com/contactus. 
 
For information on documentation support, visit support.dell.com/manuals. On the Manuals page, click 
Software ‐>Systems Management. Click on the specific product on the right‐side to access the documents.  
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